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Chapter 253

Tests for Two
Ordered Categorical
Variables
Introduction
This module computes power and sample size for tests of ordered categorical data such as Likert scale data.
Assuming proportional odds, such data can be analyzed directly with a z-test, or using logistic regression or the
Mann-Whitney test. The power and sample size formulae presented here are consistent with any of these analysis
methods. The results used here were presented in a paper by Whitehead (1993). They are also mentioned in the
book by Julious (2010) and Machin et al (1997).
Ordered categorical data often results from surveys such as a quality of life (QoL) survey in which responses are
categories such as very good, good, moderate, poor. When there are only two categories, an analysis using two
proportions should be used. When there are more than two responses, and those responses can be ordered, the
techniques described in this chapter can be used.

Technical Details
Suppose a variable has K possible responses C1 ,..., CK . Further suppose that these categories can be ordered so
that Ci is more desirable than C j if i < j. Hence C1 is the best outcome and CK is the worst. This procedure
compares the results from two groups which will be called control (C) and experimental (E). The number of
respondents falling within the i th category of the control group is labeled N i1 . The total number in the control
group is N1 and in the experimental group is N 2 . The total sample size of the study is N = N1 + N 2 .
Let piE denote the probability that an individual in the experimental group gives response Ci , and let QiE be the
probability of an outcome of Ci or better. Thus QiE =

i

∑p
j =1

jE

. Define piC and QiC similarly for the control

group. Define the log-odds ratio for a particular category as

 QiE
 1 − Q
iE
θi = log 
QiC

 1 − QiC



 i = 1,  , K − 1 .
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This measures the advantage of the experimental group over the control group. A positive θi indicates that the
experimental treatment is better than the control treatment.

Proportional Odds
The proportional odds model assumes that all of these log-odds ratios are equal to a common value θ . That is, the
proportional odds assumption is that θ1 =  = θ K −1 = θ . Thus the whole pattern of response differences can be
summarized a single parameter.
The formulae to follow use the fact that efficient score Y is asymptotically normally distributed when θ is small
and n is large. The test statistic and power formulae are as follows.

Y=
Z=

1 k
∑ N i1 (LiC − U iC )
N + 1 i =1
Y − µY

σY

i −1

LiC = ∑ N j1 , i = 2,..., K
j =1

U iC =

K

∑N

j = i +1

j1

, i = 1,..., K − 1

L1C = U KC = 0

µY = θV

σ Y2 = V
NN N
V= 1 2 2
3(N + 1)

3
K

 N i1 + N i 2  
 
1 − ∑ 
N
 i =1 
 

NN N
≈ 1 2 2
3(N + 1)

3
K

 piE + piC  
 
1 − ∑ 
2
 i =1 
 

The null hypothesis H 0 : θ = 0 (the two treatments are equivalent) can be tested against the alternative

H a : θ ≠ 0 by computing Z and rejecting if Z is greater than zα / 2 . That is,
P (Z > zα | θ = 0) = α / 2
The power is the probability of rejecting a false null hypothesis, thus the power for a specified value θ R is

Power = P (Z > zα / 2 | θ = θ R )

(

= 1 − Φ zα / 2 − θ R V

)

If a one-sided test is needed, replace α / 2 with α .
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are θ, Sample Size (N1), Sample Size (N2), or Power.

Test
Null Hypothesis
Indicate whether the hypothesis is one-sided or two-sided. If two-sided is selected, alpha is automatically divided
by 2, so you do not need to half alpha.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis
is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of θ = 0 when,
in fact, θ > 0 .
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis that θ = 0
when in fact it is.
Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means
that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that
represents the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
Note that when you are analyzing a two-sided test, you should enter alpha, not alpha/2.
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Sample Size (When Solving for Sample Size)
Group Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.

•

Enter N1, solve for N2
Select this option when you wish to fix N1 at some value (or values), and then solve only for N2. Please note
that for some values of N1, there may not be a value of N2 that is large enough to obtain the desired power.

•

Enter N2, solve for N1
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Group 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.

N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1, solve for N2”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed if Group Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
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R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)
Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.

•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.

•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Group 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.
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Sample Size Per Group
This option is displayed only if Group Allocation = “Equal (N1 = N2).”
The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.
The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 =
R * N1.”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 2.
You can enter a single value or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.
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Effect Size
Control Group Category Proportions
This option contains the piC , the proportions in each category of the control group. The number of categories is
implied by the number of items in the list.
For example, an entry of “20 30 40 10” implies that there are four categories and that 20% are category 1, 30%
are category 2, 40% are category 3, and 10% are category 4.
The first category is the assumed to be the best outcome and the last category is the worst. Also, the categories are
assumed to be ordered so that each is no better than the previous category. For example, you might have
categories Very Good, Good, Neutral, Poor, Very Poor.
Note that the values entered here should to one. If they do not, they are scaled so that they do. For example, the
values “20 30 40 10” (which sum to 100) are scaled to “0.2 0.3 0.4 0.1” (which sum to one).
You can enter any list of positive, non-zero numbers. For example, if you wanted to indicate that you have five,
equally-likely categories, you could enter “1 1 1 1 1.”
θ (Log Odds Ratio of Treatment Group)
Enter one or more values of θ, the logarithm of the odds. This value represents the effect size to be detected by the
study. Note that the log odds ratio is assumed to be constant for all categories.
Examples
0.25 0.5 0.75 1.0
0.8 to 1.4 by 0.2
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Example 1 – Finding the Power
Suppose a clinical trial is planned to compare the response, made by a doctor, to certain treatment. The subjects
are divided into two groups: those that will receive the current treatment and those that will receive an
experimental treatment. Three months after the administration of the treatment, the doctor rates the response as
very good, good, moderate, or poor. Historically, the responses have been about 20% very good, 50% good, 20%
moderate, and 10% poor.
The researchers want to consider a range of possible value of θ from 0.5 to 2.0. They want to look at the power
achieved by sample sizes from 30 to 150 per group. They want to set alpha to 0.05 and analyze the results with a
two-sided test.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for Two Ordered Categorical Variables procedure window by expanding Proportions,
then clicking on Ordered Categorical, and then clicking on Tests for Two Ordered Categorical Variables.
You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and
choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Null Hypothesis ....................................... Two-Sided
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
Sample Size Per Group .......................... 30 to 150 by 10
Control Group Category Proportions ...... 20 50 20 10
θ (Log Odds Ratio of Treatment Group) . 0.5 to 2.0 by 0.5

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Two-Sample, Ordered-Categorical Test
Null Hypothesis: θ = 0 Alternative Hypothesis: θ ≠ 0

Power
0.1726
0.5310
0.8653
0.9828
0.2172
0.6564
0.9444
0.9972
0.2613
0.7543
.
.
.

N1
30
30
30
30
40
40
40
40
50
50
.
.
.

N2
30
30
30
30
40
40
40
40
50
50
.
.
.

N
60
60
60
60
80
80
80
80
100
100
.
.
.

Trt Control
Trt
Log Odds Categ. 1 Categ. 1
Ratio
Prop.
Prop.
θ
PC(1)
PE(1)
0.5000 0.2000 0.2919
1.0000 0.2000 0.4046
1.5000 0.2000 0.5284
2.0000 0.2000 0.6488
0.5000 0.2000 0.2919
1.0000 0.2000 0.4046
1.5000 0.2000 0.5284
2.0000 0.2000 0.6488
0.5000 0.2000 0.2919
1.0000 0.2000 0.4046
.
.
.
.
.
.
.
.
.

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
.
.
.
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Report Definitions
Power is the probability of rejecting a false null hypothesis.
N1 and N2 are the number of subjects in the first and second groups.
N is the total sample size, N1 + N2.
θ is log odds ratio = log[odds(experimental)/odds(control)].
PC(1) Control Cat. 1 Prop. is the proportion or probability of the first (best) category of the control group.
PE(1) Trt Cat. 1 Prop. is the proportion or probability of the first (best) category of the treatment group.
Alpha is the probability of rejecting a true null hypothesis.
Summary Statements
Samples of 30 subjects in the control group and 30 subjects in experimental group achieve 17%
power to detect a change in the log odds ratio (θ) of 0.5000 when the significance level
(alpha) is 0.0500 using a two-sided test.

This report shows the numeric results of this power study. Following are the definitions of the columns of the
report.
Power
This is the probability of rejecting a false null hypothesis.
N1, N2
This is the number of subjects in the control group and experimental group, respectively.
Log Odds Ratio
This is the log of the odds ratio. It is calculated using the formula

 QiE
 1 − QiE
θ = log 
Q
 iC
 1 − QiC



 i = 1,  , K − 1 .



Alpha
This is the probability of rejecting a true null hypothesis. This is often called the significance level.
Beta
This is the probability of accepting a false null hypothesis.
Control Cat. 1 Prob. PC(1)
This is the value of p1C , the probability of a control group subject responding in category 1.
Exp’l Cat. 1 Prob. PC(1)
This is the value of p1E , the probability of an experimental group subject responding in category 1.
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Category Probability Distribution
Category Probability Distribution
θ
0.000000
0.500000
1.000000
1.500000
2.000000

Pr(1)
0.2000
0.2919
0.4046
0.5284
0.6488

Pr(2)
0.5000
0.5018
0.4592
0.3843
0.2964

Pr(3)
0.2000
0.1432
0.0969
0.0631
0.0400

Pr(4)
0.1000
0.0631
0.0393
0.0242
0.0148

This report shows the individual response probabilities. The first row contains the results for the control group
where θ is zero. The next row gives the values of piE for each value of θ. The goal of the report is to let you
study the impact on the piE of each value of θ. You can make this assessment by watching how much these values
change over the corresponding value in the first row.

Plots Section

253-10
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Tests for Two Ordered Categorical Variables

This plot gives a visual presentation to the results in the Numeric Report.
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Example 2 – Finding the Sample Size
Continuing with Example 1, the researchers want to find the sample size necessary to achieve 90% power when θ
is 0.9.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for Two Ordered Categorical Variables procedure window by expanding Proportions,
then clicking on Ordered Categorical, and then clicking on Tests for Two Ordered Categorical Variables.
You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and
choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Null Hypothesis ....................................... Two-Sided
Power ...................................................... 0.9
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
Control Group Category Proportions ...... 20 50 20 10
θ (Log Odds Ratio of Treatment Group) . 0.9

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Two-Sample, Ordered-Categorical Test
Null Hypothesis: θ = 0 Alternative Hypothesis: θ ≠ 0

Power
0.9000

N1
92

N2
92

Trt
Log Odds
Ratio
N
θ
184
0.9000

Control
Categ. 1
Prop.
PC(1)
0.2000

Trt
Categ. 1
Prop.
PE(1)
0.3808

Alpha
0.050

The required sample size is 92 in each group.
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Example 3 – Validation using Whitehead (1993)
Whitehead (1993) has an example in which he calculates the sample size to be 94 when θ is 0.887, alpha is 0.05,
power is 90%, the control group proportions are 0.2, 0.5, 0.2, and 0.1.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Tests for Two Ordered Categorical Variables procedure window by expanding Proportions,
then clicking on Ordered Categorical, and then clicking on Tests for Two Ordered Categorical Variables.
You may then make the appropriate entries as listed below, or open Example 3 by going to the File menu and
choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Null Hypothesis ....................................... Two-Sided
Power ...................................................... 0.9
Alpha ....................................................... 0.05
Group Allocation ..................................... Equal (N1 = N2)
Control Group Category Proportions ...... 20 50 20 10
θ (Log Odds Ratio of Treatment Group) . 0.887

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for Two-Sample, Ordered-Categorical Test
Null Hypothesis: θ = 0 Alternative Hypothesis: θ ≠ 0

Power
0.9000

N1
94

N2
94

Trt
Log Odds
Ratio
N
θ
189
0.8870

Control
Categ. 1
Prop.
PC(1)
0.2000

Trt
Categ. 1
Prop.
PE(1)
0.3777

Alpha
0.050

PASS matches the required sample size of 94 per group.
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